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1) Use of BioSemi software  
 

a) BioSemi 3 System 
The current product is the Active3 system.  

 

b) Computer for EEG 
Log in via “other users” with your VUB account on the computer for EEG recording. The first 
time, you have to send a confirmation and install your PIN (take the typical one you use, 
to avoid forgetting). 

Select the C\Users\Public\Desktop and you will see links to the “ActiView”, “ActiRead” 
and “ActiTools” program to use with Biosemi Active 3. Click these links to start the 
program. 

Known issues: 
• After clicking “ActiRead”, Windows erroneously opens a warning screen. Simply 

ignore the message, select “more information” and then “run anyway”, and when 
asked to enter the admin credentials, click any key. The program then opens. 

c) Computer for presentation of experiment to participants 
Upon startup, choose “Eprime”. Within this startup, use the account “Testafname” – 
password is MichaelPosner1. 

Do NOT put your experiments / collect your data through the USB ports of the PCs. Use 
the central LAN server (which runs antivirus, unlike the cubicle PC’s).  

Consult the Lab manual for further information. 

d) Eprime – EEG/BioSemi Cabling and Hardware 
To send the triggers from Eprime to the BioSemi system, a connector ("trigger interface") is 
required: https://www.biosemi.com/faq/USB%20Trigger%20interface%20cable.htm. 
Although E-prime insists on a "serial" port, communication actually runs via USB.  

Basically, you need to use this cabling setup: 

https://www.biosemi.com/faq/USB%20Trigger%20interface%20cable.htm


   
 

   
 

 

The orange optical cable connects to the amplifier (purple box in the middle), the black cable 
on the top connects to the E-prime / presentation “participant” desktop, and the laptop 
pictured here is the recording “EEG” laptop.  

You can test this trigger interaction in ActiView, even without connected EEG electrodes, but 
you need to turn on the amplifier. How to do this, is explained below. 

e) Sending E-prime triggers to BioSemi Software 

1. Determine the port number through which the trigger interface is connected: 

In the Posner lab, this is typically COM3. But in case of trouble shooting, do the following: 

• On the “EEG” laptop 
• Go to Device Manager  
• Go to the "Ports (COM & LPT)" section 
• If it's not listed (common on newer PCs): 

- Open "Device Manager" 
- Select the "Action" menu -> "Add legacy hardware", then click "Next" 
- Select "Install the hardware that I manually select from a list (Advanced)" -> 

then click "Next" 
- Scroll down, then select "Ports (COM & LPT)", then click "Next" 
- Select "Manufacturer" as needed (in this case, I'm selecting the standard type 

or default option), then click "Next" 
- Finish! 

• Connect the BioSemi Trigger interface via USB. 
• Somewhere in the "Ports (COM & LPT)" section, a new device will appear with the 

addition "COM" and a number. This number is necessary to establish communication 
between E-prime and the recording PC. (In the Posner lab: COM3). 



   
 

   
 

2. Configure E-prime correctly: 

• On the E-prime / “participant” desktop 
• Start your Eprime Studio program 
• Go to Edit > Experiment > Devices 
• Add > Serial 
• Serial > Edit 

- COM port: as identified in step 1 (In the Posner lab: COM3). 
- Data Rate: 115200 
- Data Bits: 8 
- Parity: none 
- Stop Bits: 1 
- (Flow Control: off) 

3. Program the codes you want to transmit at the appropriate times: 

• On the E-prime / “participant” desktop 
• You can use any number from 1 to 255 as trigger code. Correct use of these codes in 

the experiment itself is essential. Code "0" doesn't seem to work, so don't use it.  
• There are two methods: 

- Via InLine: "Serial.WriteByte 100" will return the code 100 when the trigger is 
executed. 

- More user-friendly: via TaskEvents (tab in the properties of a stimulus object) 
• Task: Select "Serial" 
• Action: WriteByte 
• Custom: Variable containing the correct code 
• Delay: 0 
• Data type: Byte 

- You can link the trigger to the appearance of a stimulus, the disappearance of a 
stimulus, a response, etc. 

- It is not possible to write letter inputs from the keyboard directly as bytes. For 
this, you must use an inline function. 

- You can, however, link any arbitrary code to a correct or incorrect response.  

4. Displaying triggers in ActiView 

• On the “EEG” laptop 
• The maximum amount of information contained in a trigger = 1 byte = 8 bits = 28 (every 

possible combination of 8 x 0 or 1). This results in a total of 256 possible combinations, 
which is why the possible codes are limited to a digit from 0 to 255. 

• By default, these are displayed in the trigger channel at the bottom of ActiView as a 
combination of up to 8 colored squares. To enable correct tracking, it is sometimes 
more convenient to see the programmed codes written out. This can be done via the 
left main menu “Trigger Format” > “Custom”. 

 



   
 

   
 

2) Before each EEG measurement 
Before the effective start of an EEG measurement, it is advisable to check that you have the 
following items ready: 

• A fully charged battery + adapter. An indicator light shows when the battery level is low. 
In that case, you can only count on 30 to 60 minutes.  

• Electro-Gel: green tube, store upright  
• Plastic syringe to apply the gel and push the hair out of the way 
• Electrode rings (stickers) 
• (Medical) tape: for additional sticking of the electrodes on the face. If necessary, tear off 

some particles already so you can reach them better and faster later. 
• Disinfectant gel (COVID and skin disinfection), Detol (cleaning material). 
• Swabs or wipes if skin needs to be disinfected, ether and facial scrub  
• Head caps: different sizes (S-M-L) and measuring tape 
• Electrodes: normal series and 6 flat electrodes for face and mastoid  
• CMS and DRL electrodes (grounding): check for blue light (problem) 
• A/D box (near participant) and interface 
• Optical cable: from A/D box to interface  
• USB cable: from interface to computer 
• Computer for EEG recording: further away 
• Scissors, kitchen roll or other paper, towel and shampoo for participant, gloves for 

hygiene 
• Notebook for any comments on measurements/stimulation sessions  
• Washed hands 

Connect the A/D box to the interface using the long orange cable and connect the interface to 
the computer with the black USB cable and to the computer with E-prime using the second 
black cable (with thick end at the back of the interface). Connect this cable next to the HMDI 
cable in the E-prime laptop (2nd port). 

3) EEG recording: preparation 
Introduce yourself to the participant and explain what will happen today. As you go through the 
steps, mention to the participant what you are just doing so that they remain at ease. Also, at 
sufficient times, ask if the person has any questions. Indicate that this is not an electric shock 
or the like and that the gel may feel a little cold. 

Ask if the participant might want to go to the restroom! 

a) Placing electrodes 
Place the EOG electrodes. Take a double adhesive sticker and place it on the electrode. Clean 
the spot on the face with some ether on a cotton ball or ear stick and scrub behind the ears 
(concretely: wipes > scrub > ether behind ears and cloth > ether on other spots). Fill the 



   
 

   
 

electrode with gel (from the jar). Remove the protection from the sticker and place the electrode 
in the correct position:  

• EX1: on left mastoid behind left ear 
• EX2: on right mastoid behind right ear 
• EX3: 1 cm left of left eye (flush with center of eye) 
• EX4: 1 cm to the right of right eye (flush with center of eye) 
• EX5: 2 cm above right eye (flush with center eye, may also be left depending on setup)  
• EX6: 2 cm below right eye (level with center eye, ditto)  

If necessary, apply additional medical tape to ensure that these electrodes stay securely in 
place.  

Make sure the electrodes do not hit anything or the like. Plug the electrodes into the correct place 
in the amplifier. 

b) Placing cap 
Proceed with placing the cap on the participant's head. To do this, measure the circumference 
of the participant's head to select the correct size of cap. Do this just above the eyebrows at the 
front and the inion at the back of the head. See below which size cap fits best (take 4 cm slack): 

• S/M: 52-56 cm (electrodes to be replaced by cups) 
• M: 54-58 cm (most used and already equipped with HD-tDCS cups) 
• M/L: 56-60 cm (most used and already fitted with HD-tDCS cups) 
• L: 58-62 cm (electrodes still to be replaced by fairings) 

Please note the following when placing the cap:  

• Tie long hair together in a low ponytail 
• Make sure the cap sits properly and the ears fit into the holes provided 
• Iz should be situated above the inion 
• Cz should be situated in the exact center of the inion and the nasion (use tape measure) 
• (Fpz should be located exactly 10% of the distance between inion and seam) 
• Measure from ear to ear and make sure the center line is at exact center 
• Make sure the cap is set up symmetrically: stand in front of the participant to check this 
• Move the cap with both hands  

After this, close the tape under the chin. Make sure it is not too tight to avoid discomfort to the 
participant. If necessary, insert a handkerchief between the closure and the participant's chin. 
After this, check one last time that Iz is properly situated. Remove the label from the cap! 

In large people, you can ask them to put their head back a little while putting on the cap.  



   
 

   
 

c) Filling containers and placing electrodes 
Fill the plastic syringe with Gel (about 10 ml). Carefully fill all the ports of the. First push the hair 
slightly to the side with the tip of the syringe. Then position the tip of your syringe almost against 
the scalp and inject the gel into it (about ¾ of the holder). Pull the syringe out of the holder while 
filling it. Be sure not to squirt too much gel into the holder and remove excess gel. Ask the 
participant if he/she feels the gel. If not, you need to push the hair aside a little more. Do not use 
too much gel! 0 

Place the different ribbons of electrodes around your neck and now click the electrodes in their 
corresponding places. Work ribbon by ribbon and start with the DMS and CRL electrodes! Point 
the electrodes toward the back (the interface) so there is less tension on the wires. If necessary, 
tape the bundles to the participant's shoulders using velcro. 

d) Electrodes in BioSemi converter  
If necessary, wash your hands to remove any excess gel. Then plug in the different ends of the 
different ribbons etc. to the appropriate place in the A/D box. The ribbons should be clicked in 
at the top. Make sure this is in the correct direction. Make sure that no gel or the like ever gets on 
this side of the electrode plug! 

Check that all steps were performed. Connect the battery to the box and turn on the device. You 
will then see a green light if the battery is sufficiently charged. 

Next, check that the blue light 'CM in Range' lights up. Do not flicker! If the light is flickering, 
check that there is enough gel in the CMS and DRL holders and those same electrodes are 
properly attached and that the cables were plugged in properly. If necessary, move the bristles. 
If necessary, check the troubleshooting of the ActiveTWo User's Guide (see Appendix). 

Before starting the measurement and checking the electrodes, give the gel about 5 to 10 minutes 
to take effect (this is approximately automatic). If necessary, tape the leads to the participant at 
the level of the shoulder. 

e) Guidelines for participant 
Give the participant the following instructions for optimal EEG measurement: 

• Relax as much as possible, do not grit your teeth, etc. 
• Remain calm in case of mistakes or frustration 
• No chewing gum, sweets, etc. 
• Cell phone completely turned off or placed outside the room 
• As little movement, blinking, etc. as possible. (no excessive focusing) 
• As little blinking as possible while participating in the experiments 
• Complete the two tasks as best as possible 

Provide necessary feedback during the measurement regarding movement, blinking, etc. and 
show the effects of movements if necessary. 



   
 

   
 

 

4) EEG measurement: recording 
Open the program “Actiview.” The program will ask you to select a file. Navigate to “confguring” 
and select the “64+8 file”. On the left side of the screen are settings that affect what you see, 
but not what is recorded on it. On the right side are settings that affect the recording.  

Once opened, press start to start and show the signals. Note that you are not recording anything 
at this point. Designate the electrodes you want to record (Save subset A1-B32). Add the 
additional EOG electrodes (add Displayed sensors/add EXG). Next, you get a new file that you 
can give a location and name. Give the file a clear and systematic name. 

Change the trigger format to decimal (about configure -> decimal) and keep the speed 
mode/sample rate at 4 (how many times per second a signal is transmitted; setting on device 
itself). This is automatically associated to 512 Hz. In addition, choose the reference electrode: 
none/EOG1 and 2 (mastoid).  

Continue with a quality check: whether in the third tab “electrode offset” all blue bars are 
between 0 and -/+ 25 and/or they do not fluctuate or flicker too much. Series A+B (left of screen) 
contain the 64 electrodes, series G+H the EOG electrodes. When electrodes are out of bounds 
it is best to check if the electrode is seated properly, you can manipulate the gel a bit, add gel or, 
worst case, you can use another electrode externally (e.g. A23 becomes EX7). The latter is a 
very last resort. Also do a quality check for the EX channels (left, same x-axis). Especially the 
first and second (mastoid) are very important there! 

Also look at the display (do this separately for series A and B if necessary) to see if there are any 
irregularities or noise (see Figure 1, for example). If any problems are observed, there may be not 
enough or too much gel in the holder or the electrode may not be properly seated in the holder. 
Remember that the gel only works after about 10 minutes. In case of problems, check the 
previous situations. While doing so, disable the highpass and lowpass filter for quality check (is 
often already automatic). Know that with too much gel there is often no more solution, so pay 
attention for this! 

  



   
 

   
 

On the second tab (bipolar leads) check if the EOG electrodes are properly registered.  

Note: See https://cortechsolutions.com/ufaqs/can-change-actiview-cfg-file-displays-saves-
correct-channel-labels-system/ to display correct electrodes etc. by default. 

Next, verify that you are effectively recording. Do this by going to the first tab and indicating 50uV 
and then asking the participant to close his/her eyes. You should then be able to see an alpha 
rhythm in the EEG. Go to the second tab and ask the participant to move the eyes from left to 
right: this should be visible in EX1 and EX2. Finally, ask to move the eyes from top to bottom and 
check this in EX3 and EX4. Finally, ask them to bite their teeth and see the effect on the display. 

After you pushed start file, the pause button is still active. So you still have to push the pause 
button to effectively start. When you record effectively, the “total saved indicator” should go up. 
Keep an eye on the measurement as the answers are recorded. You can always pause again by 
pressing “pause save” and then click “paused” again. 

a) Resting state EEG 
After the recording has started, you can start the resting state EEG.  

Instruct participant to close eyes in a moment and just sit quietly (do not fall asleep). Start 
recording and give trigger F2 to start and F2 to stop the resting state. Time the 4 minutes on a 
timer and then continue with the computer tasks (measurement can be done as usual). 

b) ERP recording 
Then proceed with the ERP recording during the 2 experiments.  

Start the E-prime experiment. Verify that the triggers come through correctly. During the tasks, 
monitor the measurements. Give instructions to participant if it moves too much or the like, or 
adjust signals in case of bad contacts/bad signals. 

Note: pauses can be skipped by tapping the space bar. Close E-prime by pressing 
CTRL+ALT+SHIFT. 

Then stop the measurement by pressing Pause Save and then Stop. 

 

5) EEG: removing and finalizing 
a) Removing material 

Turn off the AD box and remove the battery from the amplifier. Now remove the electrodes from 
the cap first. Remove the ribbon of EEG electrodes first at the box and then remove the 
electrodes 1 by 1 from the cap. Do not remove the electrodes by the wire, but rather grasp the 
electrode itself and pull perpendicularly away from the cap. Hang the electrodes around your 
neck and then, when a bundle is completely removed, hang the bundle away in the appropriate 
place. In the case of the tubs, open the holders and put the lid away. Carefully clean the 
electrodes with tap water and dry carefully before repacking everything. 

https://cortechsolutions.com/ufaqs/can-change-actiview-cfg-file-displays-saves-correct-channel-labels-system/
https://cortechsolutions.com/ufaqs/can-change-actiview-cfg-file-displays-saves-correct-channel-labels-system/


   
 

   
 

Use paper to remove excess gel from the participant 's head. If necessary, use water or have the 
person wash his/her hair. 

Remove the EOGs. Do this first to the box and then to the participant himself. Do this carefully, 
especially if there is extra tape around the participant's eyes. 

Give the participant a towel and shampoo and escort him/her to where hair can be washed, if 
desired. 

b) Cleaning material 
Get to work cleaning the electrodes yourself. Always put them in a plastic bath or bucket, never 
directly in the metal sink! Clean them with cold lukewarm water. Then dry them very carefully 
with a towel or soft cloth and let them dry by themselves. Optionally, you can also use some 
soap, if cleaning must be persistent. Do not use any other agents! 

Clean the cap with warm water and detol. Pay attention to the labels. If necessary, use a small 
brush or toothbrush for the holders. Check that they are completely clean, especially in the 
different holders. Hang the cap to dry further or use a hair dryer if your next participant follows 
quickly. 

Clean up other items, throw away used paper and gather everything together. Store everything 
safely. 

c) Charging battery 
Connect the battery to the charger. It takes about 3-4 hours to fully charge an empty battery. 
When the LED light is green, the battery is fully charged. When the yellow light, the battery is 
90% charged. When the red light is on, the battery is still charging. 

 

6) Relevant Video’s:  
BioSemi Active 2 EEG training at UCD Psychology 

CortechSplanations - Biosemi ActiveTwo - Setup, Recording EEG, and Cleanup 

 

https://www.youtube.com/watch?v=xC6sMxRb3_U
https://www.youtube.com/watch?v=r4JmfPZzc-E

